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AVEVA Edge Import Tool
Schneider-Electric introduces the AVEVA Edge Import Tool — a powerful, flexible,
easy-to-use tool that expands the capabilities of your installed plant-floor systems.
You can use the AVEVA Edge Import Tool to import applications created with
PanelBuilder
(Allen-Bradley’s programmer for PanelView Human Machine Interfaces (HMIs)) into
AVEVA Edge (VXL) using a fast and intuitive wizard.

Using the AVEVA Edge Import Tool
to Import PanelBuilder Applications to VXL
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After importing an application into AVEVA Edge, you can take advantage of these AVEVA Edge
features:
▪ Flexibility: AVEVA Edge can run the application on any Microsoft® Windows®
platform (NT/2000/XP or CE). For example, you can run the application on
devices powered with Windows CE, such as HMI panels and PDAs (iPAQ,
Toshiba, Dell, and so forth.)
▪

Expansibility: You can use the AVEVA Edge development suite to add functionality
to your application (historical data, XML reports, math scripts, and so forth).

▪

Connectivity: Because the application is running under the AVEVA Edge runtime,
you can take advantage of all connectivity tools embedded in the AVEVA Edge
package, such as:
–

Communication drivers for several protocols from different manufacturers
(Modbus, Profibus DP, DeviceNET, ControlNET, Siemens S7 – MPI/PPI,
Siemens S5 – RK512, GE-Fanuc SNP/SRTP and many others)

–

OPC Client and Server interfaces

–

XML and ADO interfaces to exchange data with third-party systems, such as
Enterprise Resource Planning (ERP) systems

–

API Toolkits to integrate the application with third-party programs written in
any language that supports DLLs (VB, C, C++, and so forth).

–

TCP/IP modules for redundant and networked applications

–

Web solution that provides remote access to your application using just a
Web Browser, through any TCP/IP link (Intranet, Internet, or dial-up
connection)

–

Remote management and debugging tools that allow you to manage
(download, upload, run, stop, and debug) your application remotely from a
development station.

The AVEVA Edge Import Tool’s greatest advantage is how easy it is to use — which
can dramatically reduce the cost and hassle of modernizing the automation systems
in your facility.
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Import Requirements
To import a PanelBuilder application you must install the following software on your
computer:
1. AVEVA Edge with the AVEVA Edge Import Tool add-on
2. PanelBuilder programming software
3. PanelBuilder application file (.pba file)
 Note:
You can run the AVEVA Edge development system on Windows NT/2000/XP operating
systems. For detailed information about AVEVA Edge’s hardware and software
requirements, see the AVEVA Edge User’s Guide and Technical Reference.

Import Procedures
The AVEVA Edge Import Tool provides a simple, straightforward wizard to guide you
through the process of importing PanelBuilder projects into AVEVA Edge. This
import process consists of three steps:
1. Installing a Generic / Text only printer
 Note:
To generate a PanelBuilder application report, you must use the Generic/Text only
printer provided with your computer operating system. If you already have this printer
installed on your system, you can skip step 1.
2. Generating a PanelBuilder application report
3. Importing the application using AVEVA Edge Import Wizard

Step 1 – Installing the Generic / Text Only Printer
To install the Generic / Text only printer that comes with your operating system,
follow these steps:
1. Click the Windows Start button and then select Settings → Printers.
2. In the Printers window, double-click the Add Printer icon to start the Add Printer
wizard.
3. When the wizard Welcome screen displays, click Next to open the Local or
Network Printer screen.
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4. Click (enable) the Local Printer radio button and clear (disable) the Automatically detect
and install my Plug and Play printer check box. Click Next to continue to the next screen.

Local or Network Printer Screen
5. When the Select the Printer Port screen displays, select FILE: Print to File from the
list of Ports, and then click Next.

Selecting the Printer Port
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6. On the Add Printer Wizard screen, select Generic from the Manufacturers list and
select Generic / Text Only from the Printers list. Click Next to continue.

Adding a Generic Printer Wizard
The Wizard will take you to three more screens, as follows:
▪

Name Your Printer: Allows you to specify a name for the new printer and
make it your default printer.

▪

Printer Sharing: Allows you to share this printer.

▪

Print Test Page: Allows you to confirm that the printer installed correctly by
printing a test page.

7. You can change any of the default parameters and then click Next to progress
through the screens, or simply accept the default settings on each screen by
clicking Next.
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8. When the Completing the Add Printer Wizard screen displays, verify the
information displayed and if there are no changes, click Finish.

Final Screen
Now you are finished installing the printer. Continue to the next section and
following the instructions for generating the PanelBuilder application report.

Step 2 – Generating a PanelBuilder Application Report
This section explains how to generate a PanelBuilder application report:
1. After you install the Generic / Text only printer, open your PanelBuilder
application to generate the report.
2. Select Tools → Options from the PanelBuilder menu bar, and when the Options
dialog displays, select the Report Setup tab.

Page 9 of 25

AVEVA Edge® Import Tool for PanelBuilder™

3. Click (enable) the options shown in the following figure and then click OK.

Options Dialog
4. Select File → Reports from the PanelBuilder menu bar.
5. When the Print Reports dialog displays, click the Printer Setup button.

Print Reports Dialog
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6. When the Print Setup dialog displays, click the Name combo-box button and select
Generic / Text only from the list.

Selecting the Printer
7. In the Paper section, click the Size combo-box button and select the A3
paper size.

Selecting the Paper Size
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8. In the Orientation section, click Landscape, and then click OK.

Selecting the Paper Orientation
9. When the Print Reports dialog displays again, clear (disable) the Screen Images
check box and then click the Print button.

Clearing the Screen Images Check-Box
10. When the Print to File dialog displays, enter a file name and location for the
report, and then click OK.

Specifying a File Name
PanelBuilder will save the resulting file to the designated location. Now you can
import this file into AVEVA Edge, continue to the next section for instructions.
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Step 3 – Importing the Application Using AVEVA Edge
After generating the application report, you can import the information from that
report into VXL and automatically create a new VXL application with the same
characteristics as your original PanelBuilder application.
Use the following procedure to import the PanelBuilder application report into VXL:
1. Start AVEVA Edge by selecting Start → Programs → AVEVA Edge → AVEVA Edge.
2. Select Home > Tools > Import Wizard to open the AVEVA Edge Import Tool Wizard:
 Note:
You can use the VXL Import Wizard to import application data from sources other than
PanelBuilder applications. For more information about importing other application types,
refer to the AVEVA Edge Users Guide and Technical Reference.
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3. When the Import Wizard dialog displays, select PanelBuilder Application from the
Source Type list, and then click Next.

Selecting the Application to Import
The Import PanelView Application Wizard dialog displays:

Import PanelBuilder Application Wizard
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4. Use this dialog to specify the following import parameters, and then click Next.:
▪

Do not import duplicate tags radio button: Click (enable) this option to prevent the
Import PanelBuilder Application Wizard from importing tags with the same
name as tags in the current VXL application database.

▪

Replace duplicates with tags imported radio button: Click (enable) this option if you
want the Import PanelBuilder Application Wizard to replace duplicate tag
properties in the current VXL application database.

▪

Use prefix check-box: Click (enable) this option if you want to add a prefix to
all imported tags. Because you can import multiple PanelBuilder applications
into a single VXL application, this feature is provided to help you identify
where the imported application tags originated and avoid duplications.
Simply type a prefix into the text field.

▪

Import Screens check-box and text field: Clear (disable) this option to prevent
the Import PanelBuilder Application Wizard from importing the PanelBuilder
application screens.

▪

Import Comm. Configuration check-box: Clear (disable) this option to prevent the
Import PanelBuilder Application Wizard from importing the communication
properties configured for each tag in the PanelBuilder application.

▪

Report File text field: Type the name of the PanelBuilder report file you
generated on page 8.

The Import PanelBuilder Application Wizard will read the report file and then
display a new dialog listing all the tags in the report file (similar to the following
figure).

List of Tags in the Report File
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The tags are color-coded to indicate which tags will be imported:
▪

Blue tags will be imported. (If you do not want to import one of these tags,
simply clear (disable) the check-box to the left of the tag name.)

▪

Red tags will not be imported. (If you enabled the Do not import duplicate tags
option, the Import PanelBuilder Application Wizard will not import tags that
already exist in the VXL application database.)

▪

Gray tags can be imported. Tags become gray in two circumstances:
–

You cleared (disabled) the check-box to the left of an importable (blue)
tag, which changes the blue tag to gray.

–

You have met, or exceeded, the number of tags allowed by your AVEVA
Edge license. For example, if your license allows 1,500 tags, and you
would exceed this limit by importing the grey tags, VXL will not allow the
Import PanelBuilder Application Wizard to add these tags to the VXL
database.

You can import gray tags (by enabling the check-box to the left of the tag
name), as long as you do not exceed the number of tags allowed by your VXL
license.
5. Click the Finish button to import the application according to the import
parameters you specified in the previous step.
 Note:
If your application uses bitmaps (.bmp) other than those in the standard PanelBuilder
list, export the bitmap file and copy it to the <AVEVA Edge Installation
Folder>\Lib folder.
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Release Notes
The AVEVA Edge Import Tool is still going through the development process. This
first release implements the most important features. The next list illustrates all the
features that are not imported automatically. Because both AVEVA Edge and AVEVA
Edge CEView are much more powerful than PanelBuilder is, it is possible to work
around the items that are not imported by implementing some minor changes in the
application. If your application uses one of the features that you the import wizard
does not import and you think that you will spend a lot of time implementing this
feature on your application, please contact your AVEVA Edge representative or send
an e-mail to support@AVEVA Edge.com and we will analyze the possibility of
implementing that specific feature.

Graphical Interface
The graphical tools offered by AVEVA Edge overcome the expectations when
compared with the other tools available in the market. When importing the
application using the Import Wizard, you will realize that the imported graphical
interface will look even better than the original one. However, some features
available in other products are very different from the way that AVEVA Edge
implements them. The AVEVA Edge development philosophy is to implement
Windows standards and use simple-to-use controls, making the product easy to use.
You can develop good looking screens in a few minutes. During our development
research we realized that some features available in the PanelBuilder are so
“unusual” that most of the applications do not use them. These features are not
being imported, because most of the applications that we tested against did not use
them. The following properties, unless they are explicitly declared in the graphical
compatibility list (see next topic), are not imported by the import wizard: Shape, Fill
Pattern, Graphic, Line Type and Print.
The next list has all the objects supported by PanelBuilder and the properties not
supported by the Import Wizard. Items marked in RED are features that we found in
some of the applications that we tested against and will probably be implemented for
future releases. Items marked in YELLOW are minor items that do not enhance the
graphical interface and will not be implemented unless there is a strong reason to do
so. If there is any property associated with an object that you could not find in this
list, it means that the property is not being imported and that you should contact
your AVEVA Edge representative or send an e-mail to support@AVEVA Edge.com
with the information about the specific property.
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Panel Builder Object: Pushbutton – Momentary, Maintained and Latched
AVEVA Edge Object: Pushbutton
Write Tag: Tag / Exp
Hold Time: Not Supported
Indicator/Display Tag: Indicator
Handshake Tag: Reset
Data Type/Format: Not Supported
Contact Type: State
Initial State: Not Supported
States:
Number: <0 - Open / 1 – Closed / Error – Additional Pushbutton with Position>
Graphic: Not Supported
Blink: Blink set to slow
Value: Value
FG Color: Not Supported
BG Color: Color
Text Properties: All the properties are supported, but they need to be the same
for all the states.

Panel Builder Object: Screen Selector – Goto
AVEVA Edge Object: Button with command dynamic (Open Function)
Text Properties: All the text properties are supported.
FG Color: Not Supported
BG Color: Button Fill Color
Destination Screen: Parameter passed to Open function in the button command.

Panel Builder Object: Screen Selector - Return
AVEVA Edge Object: Button with command dynamic (OpenPrevious Function)
Text Properties: All the text properties are supported.
FG Color: Not Supported
BG Color: Button Fill Color
Blink: Position Dynamic associated with the object.

Panel Builder Object: Screen Selector - Goto Config Screen
AVEVA Edge Object: Config Screen not supported
Panel Builder Object: Screen Selector - Screen List Selector
AVEVA Edge Object: List Box + Button with command dynamic (Open
Function)
Wrap List: List Box List Wrap Option
FG Color: List Box Border Color
BG Color: List Box Window Color
Fix Cursor At State: Not Supported
Text Properties: Wrap is the only text property not supported. The font size and
background color will be the same for all the items in the screen list.
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Panel Builder Object: Numeric Entry – Cursor Point
AVEVA Edge Object: Rectangle with command dynamic + Text I/O with keypad
enabled
Text Properties: Text I/O properties
FG Color: Rectangle Liner Color
BG Color: Rectangle Fill Color
Write Tag: Text I/O Expression and Keypad function call in the command dynamic.
Indicator/Display Tag: Not Supported
Notification Tag: Not Supported
Handshake Tag: Not Supported
Decimal Point: Format Function in the Text I/O Expression.
Blink: Position Dynamic associated with the object.

Panel Builder Object: Numeric Entry – Keypad Enable
AVEVA Edge Object: Rectangle + Command Dynamic to open the Keypad +
Rectangle with caption
Text Properties: Rectangle caption properties
FG Color: Rectangle Liner Color
BG Color: Rectangle Fill Color
Write Tag: Used in the command that activates the Keypad.
Indicator/Display Tag: Used in the rectangle caption.
Notification Tag: Not Supported
Handshake Tag: Not Supported
Decimal Point: Format Function in the Rectangle Caption.

Panel Builder Object: Numeric Entry – Inc/Dec
AVEVA Edge Object: Not Supported
Panel Builder Object: Control List Selector (Standard and Piloted) and
Indicator - List
AVEVA Edge: List Box
Write Tag: Write Tag
Search Tag or Read Tag: Read/Search Tag
Control Tag: Control Enable
Block Write Start Tag: Not Supported
Data Type/Format: Integer value, LSB and Single Bit are the modes supported by
AVEVA Edge.
Initial State: Not Supported
Write Value On Enter: Enter Reqd
Wrap List: List wap
FG Color: Border Color
BG Color: Win Color
States:
Number: List Box State number or Error State
Message: List Box message
Access: Not Supported
Value: Value
Text Properties: Alignment option is not supported. Text Foreground Color, Font
and Size need to be the same for all the states.
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Panel Builder Object: Graphic Indicator – Bar Graph
AVEVA Edge Object: Rectangle with Bargraph Dynamic + Rectangle with
caption
Text Properties: Rectangle caption properties
FG Color: Rectangle Liner Color
BG Color: Rectangle Fill Color
Read Tag: Expression field of Bargraph Dynamic
Fill: Bargraph dynamic Foreground Color
Blink: Applied using a Color Dynamic with Blink Slow selected.
Fill From: Direction and Origentation fields from the Bargraph Dynamic.
Min/Max Range: Min and Max values in the Bargraph Dynamic.

Panel Builder Object: Graphic Indicator – Gauge
AVEVA Edge Object: Not Supported
Panel Builder Object: Graphic Indicator – Scale Linear
AVEVA Edge Object: Set of lines representing the scale
Blink: Position Dynamic with Blinkslow attached in each line.
FG Color: Used in the line colors.
Tickmarks: Import Wizard creates a line per each tick.

Panel Builder Object: Graphic Indicator – Scale Circular
AVEVA Edge Object: Not Supported
Panel Builder Object: Numeric Data Display
AVEVA Edge Object: Rectangle
Text Properties: Rectangle caption properties
Read Tag: Used in the caption text between curly brackets.

Panel Builder Object: Indicator – Message Display and Multistate Pushbutton
AVEVA Edge Object: Smart Message Object configured to message display
Read Tag: Read Tag
Data Type/Format: Value property. AVEVA Edge supports Single Bit, LSB and
Real/Integer Values.
State:
Number: Smart Message number or Error State
Graphic: Not Supported
Blink: Rec Blink
Value: Value
FG Color: Rec (FG)
BG Color: Rec (BG)
Graphic: Graphic File
Text Properties: All the properties are supported, but the Text Font and Size
need to be the same for all the states.
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Panel Builder Object: Graphics - Line
AVEVA Edge Object: Line
Blink: Implemented using position dynamic
FG Color: Color
 Note:
There is no way to determine the direction of the line based on the report
information, so the Import Wizard will always import the lines from down to
up, left to right. In some cases the user will have to flip the lines after finishing
the import.

Panel Builder Object: Graphics – Connected Line and Free Form
AVEVA Edge Object: Not Supported
Panel Builder Object: Graphics – Rectangle, Ellipse and Circle
AVEVA Edge Object: Rectangle, Ellipse and Circle
BG Color: Fill Color
FG Color: Line Color

Panel Builder Object: Graphics – Graphic Image
AVEVA Edge Object: Bitmap
BG Color: Used to change the bitmap color when importing.
FG Color: Used to change the bitmap color when importing.

Panel Builder Object: Text
AVEVA Edge Object: Rectangle with caption
Text Properties: Rectangle caption properties
Variables: All the variables are inserted in the caption using the Format function
when format is necessary.

Panel Builder Object: List Keys
AVEVA Edge Object: Not Supported
Panel Builder Object: Alarm List and Alarm Buttons
AVEVA Edge Object: Alarms list inserted on screen, but its properties are not
configured automatically; Alarm buttons are not imported, but can be easily
inserted in the application by the user
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Communication
This release implements the most important communication drivers. However, some
of the imported drivers have some differences due the way that AVEVA Edge treats
the information. Most of the applications should not be affected by the differences,
but in some cases small changes will be necessary. The next list lists all the drivers
supported by the Import Wizard and lists the limitations of each one.

Panel Builder Protocol: Modbus
AVEVA Edge Driver: MODBU
▪

Signed and Unsigned variables will be imported as signed

▪

BCD Data Type is not supported

▪

Char Array data types are not supported

▪

Bit Arrays can only be used for readings

Panel Builder Protocols: DH+/ DH485 / DF1 / DF1 - Ethernet
AVEVA Edge Drivers: ABKE, ABTCP and ABENI
In order to communicate using DH+ or DH485, you will have to acquire a specific
board for these protocols. Please refer to AVEVA Edge ABKE driver documentation
for more information about the hardware needed.
▪ Signed and Unsigned variables will be imported as signed
▪

Double words are not supported

▪

You cannot have PLCs from different families in the same network

▪

Bit Arrays can only be used for readings

▪

Bit Arrays for counters and timers are not allowed

 Caution:
These drivers were tested against the following devices: PLC5, Slick PLCs,
Micrologix PLCs and Micrologix 1761-NET-ENI. According to the manufacturer
documentation, the driver should work with other devices. If you face any
problem to stablish communication with your device, please contact your
AVEVA Edge representative.
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Panel Builder Protocols: EthernetIP and ControlNet(ControlLogix)
AVEVA Edge Drivers: ABCIP
The Import Wizard does not support the ControlNet network. When the ControlNet
network is identified, the Import Wizard will convert all the tags using the ABCIP
driver for Ethernet.
▪ Network path is not supported
 Caution:
This driver was tested against the following devices: ControlLogix5000 and
FlexLogix 1761-NET-ENI. According to the manufacturer’s documentation, the
driver should work with other devices. If you have a problem establishing
communication with your device, please contact your AVEVA Edge
representative.
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Alarm Configuration
AVEVA Edge products are very powerful and manage the whole alarm system
without any additional PLC programming. PanelBuilder, however, requires the
alarms to be configured in the PLC and is only able to display the alarm messages
and provide the acknowledgment feature. Using the PanelBuilder philosophy and
migrating the whole PanelBuilder system to an AVEVA Edge system would make
applications as complex as they are in PanelBuilder. The Import Wizard has adopted
a different approach by importing the information necessary to turn on the AVEVA
Edge alarm system and displaying all the alarm messages with Acknowledge
capabilities. Depending on the PanelBuilder features that you are using on your
application, you will have to perform some minor configurations in your imported
application. Read the following topics to understand how the Alarm Configuration is
imported and which features are not imported automatically.

Alarm Banner
Instead of importing the PanelBuilder alarm banner, the Import Wizard creates an
alarm banner screen with the powerful AVEVA Edge Industrial Alarm object and all
the corresponding alarm buttons. You can eliminate some of the buttons if
necessary. The alarm banner has also a default size (the size is not imported). If the
object size is not appropriate for your application, you can open the Alarm_Banner
screen in the development environment and customize it.

Alarm Setup
Banner Pop Up: Implemented automatically by Import Wizard by selecting the alarm
banner as Pop Up or Dialog
Print Items: AVEVA Edge will print the alarms in the way that they are formated in
the alarm object. You can customize the columns as well as the order in which the
alarms will be printed. This powerful capability is imported in the alarm object that
is inserted in your screen and can be customized. Because of this functionality we
ignore the print items parameter.
Ack Hold Time and Snapshot: AVEVA Edge Industrial Alarm object is a scroll list
with many capabilities. These parameters are also not applied.
Remote Ack and Use Optional Fields: AVEVA Edge supports remote acknowledgment
by alarm message and alarm group. PanelBuilder works very differently and in some
cases the user is required to associate bits of tags to acknowledge alarms. If you are
using this functinality you will have to implement some minor scripts using AVEVA
Edge math. This parameter is ignored.
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Alarm Triggers
Trigger Tag: Tag used as a base to generate the alarm messages inside the imported
application.
Trigger Type: The Import Wizard supports Bit and Value triggers.
Ack, Remote and Handshake and Ack All: When importing the alarm list, the Import
Wizard creates an Alarm Worksheet with all the alarm messages. In order to
implement this command, the user will have to implement some additional
configuration in the worksheet.

Alarm Messages
The Alarm Messages are implemented using auxiliary tags. The name of the
auxiliary tags is formed using the formula [Trigger Tag]_Alr_[Value] where:
▪

Trigger Tag: Name of the tag used as trigger.

▪

Value: Value specified in the value column.

The auxiliary tags will have the alarm HI configured to 1 (one) with the PanelBuilder
alarm message. If the trigger is a Bit, the tag will be associated with the specific bit
in the Driver Worksheet, otherwise it will be in a Scheduler Worksheet and will go off
when the trigger value assumes the value specified in the value column. All the
parameters available in the Alarm Messages configuration are available in AVEVA
Edge, but because the concept is completely different (PanelBuilder requires that the
user configures colors per individual alarms instead of configuring per groups; they
are not automatically imported).

Security System
The current version of Import Wizard does not import the security system
automatically.
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